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SINOPSIS 

 

Data adalah alfa dan omega dari penelitian ilmiah dan sosial. 

Data  sebagai bahan mentah untuk memproduksi pengetahuan 

dan, dapat diproses dan ditafsirkan oleh seorang ahli agar 

menghasilkan produk akhir dari sebuah penelitian. Jadi, mungkin 

terdengar seperti sebuah kebenaran bahwa para peneliti harus 

secara hati-hati menangani, melestarikan, dan - jika perlu - 

membagikan data yang mereka yang mereka hasilkan dan 

gunakan. Masalahnya, hal ini bisa jadi sulit dilakukan, karena 

ilmu pengetahuan menghasilkan volume data yang sangat besar 

dari hari ke hari, hal ini tantangan untuk mengelola dan 

menyimpan informasi ini. Untuk mendorong hal ini, secara efektif 

dalam pengorganisasiannya dapat menggunakan bantuan 

aplikasi salah satunya SPSS.Buku ini berisi tentang Persiapan 

Data (pengenalan Windows SPSS dan SPSS Toolbar), 

Pengelolaan  Data (mendefinisikan variabel dan Input Data), 

Transformasi Data, Uji Validitas dan Reliabilitas (uji validitas, uji 

reliabilitas, Langkah – Langkah Uji Validitas dan Reliabilitas). 
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BAB 1 

PENDAHULUAN 

 

Statistik adalah ilmu tentang data. Sebagai dasar 

dari pengetahuan ilmiah, data mengacu pada fakta-fakta 

pembuktian dari sifat realitas oleh statistik manusia, 

observasi, atau eksperimen. Klinisi harus menyadari kondisi 

data yang baik untuk mendukung validitas, modalitas klinis 

dalam membaca artikel ilmiah, salah satu sumber daya 

untuk merevisi atau memperbarui pengetahuan dan 

keterampilan klinis (Hassani et al., 2021). Hubungan sebab-

akibat antara modalitas klinis dan hasil dipastikan sebagai 

pola statistik. Keseragaman alam menjamin pengulangan 

data sebagai bukti ilmiah dasar (Duricki et al., 2016). Variasi 

statistik diperiksa untuk mengetahui pola pengulangan. Hal 

ini memberikan informasi tentang probabilitas pengulangan 

fenomena sebab-akibat. Beberapa faktor penyebab dari 

fenomena alam membutuhkan bukti pembanding 

ketidakhadiran dalam hal kelompok control (Riffenburgh, 

2012). Pola hubungan antara faktor penyebab dan akibat 

dapat dikenali (Alfiyani et al., 2018), dan dengan demikian, 

harus diestimasi sebagai statistic hubungan (Alfiyani et al., 

2023) (Asmirati Yakob et al., 2023). Jenis dan arti dari 

setiap hubungan statistik harus dipahami dengan baik. 

Sebuah penelitian mengenai sampel dari populasi dengan 
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variasi yang luas mengharuskan peneliti untuk menyadari 

kesalahan statistik karena peluang acak  (Boucher, 1977). 

Indera manusia yang tidak lengkap, statistik pengukuran 

yang kasar, dan ide yang terbentuk sebelumnya sebagai 

hipotesis yang cenderung membiaskan penelitian, yang 

memunculkan kebutuhan akan pikiran statistik yang tajam 

dan kritis sehubungan dengan data yang dilaporkan (Choi, 

2013). 

Biostatistika adalah disiplin ilmu dengan  tatist  

tatist dan area yang luas termasuk dalam penggunaan 

aplikasi, peneliti menerapkan teori  tatistic untuk pemetaan 

masalah termasuk beberapa jenis analisis kebijakan 

sebagai bahan evaluasi (Ross, 2017) (Alfiyani, Setiyadi, et 

al., 2023). Hasil penelitian menunjukkan bahwa pemahaman 

tentang Biostatistik sangat penting bagi semua pada seluruh 

bidang keahlian, dan tidak disadari pada  tatisti besar 

pelatihan yang didapatkan merupakan bahan atau 

manjemen data dasar untuk sumber analisis  tatistic 

(Bertolaccini et al., 2017). Belajar statistik sangat mirip 

dengan belajar tentang sains: pembelajaran lebih bermakna 

jika anda dapat secara aktif menjelajahi secara mendalam 

dengan berbagai bantuan aplikasi (Curran-Everett, 2012).  

Statistik dikenal memiliki hubungan langsung 

dengan matematika dan budaya, ketakutan dan kecemasan 

yang mengelilinginya membuat asimilasi konsep dan 

metode statistik menjadi kompleks (Meng & Liu, 2022). 

Beberapa penelitian menunjukkan bahwa peneliti meskipun 
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memahami pentingnya biostatistik, tidak memiliki 

keterampilan untuk menerapkannya dengan benar dalam 

penelitian ilmiah; dan sikap tersebut, keberhasilan dan 

kegagalan dalam menghadapi tantangan statistik terkait 

dengan pengetahuan dasar. Hal ini pada akhirnya 

berdampak pada publikasi ilmiah. Analisis beberapa jenis 

variabel hasil, analisis desain studi, ukuran asosiasi dan 

dampak, dan strategi umum untuk analisis  statistik (Meng & 

Liu, 2022).  

Studi menunjukkan bahwa sering ditemukan 

kesalahan seperti desain penelitian yang tidak sesuai, 

analisis yang tidak memadai dan interpretasi yang tidak 

konsisten. Konsep dasar, yang sangat penting untuk 

menghindari kesalahan sering kali dilupakan, sehingga 

berdampak pada pemilihan uji utatistik yang digunakan 

dalam analisis data. Selain itu, statistik 

denganmenggunakan perangkat lunak statistik tidak 

menggunakan atau memilih uji statistik yang paling tepat 

untuk penelitian, sehingga menghasilkan publikasi ilmiah 

yang tidak berkontribusi pada masalah klinis, karena karena 

analisis data yang salah (Torres & Normando, 2021). 

Meskipun demikian, kami berharap bahwa dapat 

memberikan stimulus untuk meningkatkan keterampilan 

dalam menganalisis dan menginterpretasikan manajemen 

data yang baik dengan bantuan aplikasi salah satunya 

SPSS. 
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BAB II 

PERSIAPAN DATA 

 

A. Pengenalan Windows SPSS 

SPSS dijalankan melalui data view dan variabel 

view, jendela data view digunakan untuk memasukkan hasil 

data penelitian, sedangkan variabel view untuk variabel atau 

determinan dari hasil penelitian (Duricki et al., 2016).  

 

Pada dasarnya, jendela Output Viewer berfungsi sebagai 

tempat hasil analisis statistik ditampilkan; namun, perintah 

apa pun yang dipilih melalui menu drop-down atau sintaks 

akan dicetak ke jendela Output Viewer saat Anda 

melakukan perintah apa pun di SPSS. Ini mencakup 

membuka, menutup, dan menyimpan file data. Jika jendela 

Output Viewer tidak terbuka saat perintah dijalankan, 

jendela baru akan secara otomatis dibuat.  
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Menu yang ada      pada editor adalah: 

1. File 

File untuk mengelola file data, pengelolaan file yang 

dilakukan untuk membuka, membuat, mengambil, 

menyimpan (file) baik berasal dari file lama atau baru 

dapat berasal dari program lainnya. 

2. Edit 

Undo dan redo adalah menu yang sering digunakan, 

selain itu terdapat menu insert variabel, clear, cut dan 

copy.  

3. View 

View memungkinkan anda mengontrol fitur toolbar seperti 

status bar, font, label nilai, dan variabel. 

4. Data 

Data untuk kebutuhan data seperti mengurutkan, 

memverifikasi, menggabungkan, dan membagi. 

5. Transform 

Transform untuk mengubah variabel sesuai dengan standar 

tertentu, seperti penentuan data dikotomi, kasus ranking, 
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dan pengkodean otomatis. 

6. Analyze 

Analyze adalah menu utama dalam SPSS, yang setiap 

ujinya disesuaikan dengan uji statistic yang dipilih. 

7. Graphs 

Graphs untuk menghasilkan berbagai jenis grafik (bar, 

scatter, dot, Histogram, line dan pie) 

8. Utilities 

Pengaturan menu file dan tampilan, pemberian komentar 

serta menjalankan script dan sebagainya. 

9. Add-Ons 

Kebutuhan untuk membuka aplikasi serta servis 

tambahan dengan menggunakan Add-Ons. 

10. Window 

Pembagian file dapat menggunakan window 

11. Help 

Untuk mendapatkan informasi tentang program SPSS, 

seperti topik, panduan, dan instruktur statistik. 

(Norfai, 2020) 
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B. SPSS Toolbar  

Secara umum jendela Data View memiliki icon 

dengan penjelasan sebagai berikut ini: 

 

No Icon Deskripsi 

1  Open data document: file > open> data 

2  Save this document: File > save atau Ctrl + S 

3  Print: File > Print atau Ctrl + P 

4  
 

Recall recently used dialogs: Menampilkan daftar 
jendela dialog yang terakhir digunakan. Gunakan 
saat Anda perlu menjalankan ulang analisis 

5  Undo a user action: Undo atau Ctrl + Z 

6  Redo a user action: Redo atau Ctrl + Y 

7 
 

Go to case: Melompat ke kasus (baris) tertentu 
dalam set data aktif. Setara dengan Edit > Go to 
Case 

8 
 

Go to variable: Melompat ke variabel (kolom) 
tertentu dalam kumpulan data aktif. Setara 
dengan Edit > Go to variable 

9 
 

Variables: Melihat nama variabel, label, jenis, 
tingkat pengukuran, kode nilai yang hilang, dan 
label nilai untuk semua variabel di jendela aktif. 
Utilitas > Variabel 

10 
 

Run descriptive statistics: Jalankan statistik 
deskriptif (menggunakan prosedur Frekuensi) 
pada variabel yang dipilih. Statistik yang 
ditampilkan ditentukan oleh pengaturan tingkat 
pengukuran variabel. Variabel nominal dan ordinal 
dirangkum dengan tabel frekuensi; variabel skala 
dirangkum dengan menggunakan rata-rata, 
median, deviasi standar, rentang, minimum, dan 
maksimum. Hanya diaktifkan ketika sel atau 
kolom di jendela Data View dipilih. Menganalisis > 
Statistik Deskriptif > Frekuensi 

11  Find: Mencari nilai atau pengamatan dalam set 
data, atau mencari dan mengganti nilai atau 
pengamatan dalam set data. Hanya aktif ketika 
sel di jendela Data View dipilih. Edit > find dan 
Edit > replace, atau Ctrl + F dan Ctrl + H 

12  Insert cases: Menyisipkan kasus di antara dua 
kasus yang ada. Edit > Insert cases 
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13 
 

Insert variable: Menyisipkan variabel baru di 
antara dua variabel yang sudah ada. Secara 
default, variabel baru yang dibuat dengan cara ini 
adalah variabel numerik berskala. Edit > Insert 
variable 

14 
 

Split file: Mengelompokkan analisis Anda 
berdasarkan variabel kategorikal. Misalnya, jika 
variabel Jenis Kelamin dipilih di Split File, 
menjalankan statistik deskriptif pada variabel lain 
akan menghasilkan deskriptif untuk pria dan 
wanita secara terpisah. Data > Split file 

15 
 

Select cases: mengekstrak sekumpulan kasus ke 
file data baru berdasarkan beberapa kriteria, atau 
menerapkan variabel filter. Data > Select cases 

16  Value labels: Mengalihkan apakah data mentah 
atau label nilai yang ditampilkan di jendela Data 
View. View > Value labels 

17 
 

Memilih atau membatalkan pilihan set variabel 
yang akan ditampilkan di jendela aktif. Beberapa 
set dapat dipilih sekaligus. Setara dengan Utilitas 
> Gunakan Set Variabel. Perhatikan bahwa Anda 
harus terlebih dahulu mendefinisikan set variabel 
(Utilities > Define Variable Sets) agar dapat 
digunakan. 

18  Show all variables: Menampilkan semua variabel 
dalam dataset aktif. Hanya diaktifkan jika 
Gunakan Set Variabel telah digunakan. Utilitas > 
Show all variables. 

 

https://libguides.library.kent.edu/spss/environment 

 

 

https://libguides.library.kent.edu/spss/environment
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BAB III 

PENGELOLAAN DATA 

 

Manajemen data terkait dengan pengumpulan data 

dengan berbagai jenis kuesioner dan alat perekam data yang 

berbeda sesuai dengan kebutuhan jenis data. Demikian pula 

dalam analisis data, uji/metode statistik berbeda dari satu satu 

jenis data ke jenis data lainnya (Mishra et al., 2018). 

Penyajian data merupakan langkah penting untuk 

mengkomunikasikan informasi dan temuan kita kepada 

audiens dan pembaca dengan cara yang efektif. Jika 

dilakukan dengan benar, hal ini tidak hanya mengurangi 

jumlah kata tetapi juga menyampaikan pesan yang penting 

pesan yang penting dengan cara yang bermakna sehingga 

pembaca dapat memahaminya dengan mudah (Franzblau & 

Chung, 2012). Ada berbagai metode tabulasi dan grafik yang 

digunakan untuk menyajikan data, yang tidak mungkin 

dilakukan tanpa pengetahuan yang tepat tentang jenis data.  

 

A. Mendefinisikan Variabel 

Mengidentifikasi variabel sesuai pada menu SPSS adalah 

sebagai berikut: 

1. Name untuk nama (tidak boleh menggunakan spasi jika 

nama variabel lebih dari 1, bisa menggunakan _ untuk 

penghubung) 
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2. Type di sini dengan mengklik angka-angka untuk 

melihat dan menganalisisnya (numerik (data 

angka/kategori, ex:1,2,3,dll); string (kata kata, ex: 

perempuan) 

3. Widht di sini, dengan mengklik angka untuk melihat dan 

mempelajarinya 

4. Header Decimals untuk mengisi jumlah angka di belakang 

koma, contoh pada variabel tinggi badan, berat badan, 

pendapatan, ex:  4,5 kg 

5. Header label disesuaikan dengan nama variabel, jika 

variabel memiliki satuan maka pada label sebaiknya di 

beri detail satuan sesuai dengan data yang digunakan, 

ex: uang (rupiah), berat badan (kg, gram, dll) 

6. Header values untuk memasukkan coding variabel dan 

memberikan penjelasan khusus, ex: 1= Laki-laki, 2= 

Perempuan 

7. Header measure sebagai skala data variabel. Skala data 

(nominal, ordinal, interval, dan rasio) 

 Skala pengukuran adalah berbagai ukuran untuk 

mengukur variabel. Ada empat skala pengukuran: 

nominal, ordinal, interval, dan rasio. Ini merupakan 

sebuah hirarki di mana skala pengukuran terendah, 

nominal, memiliki lebih sedikit memiliki sifat matematis 

yang lebih sedikit dibandingkan dengan skala yang 

lebih tinggi (Franzblau & Chung, 2012). Setiap skala 

pengukuran memiliki sifat spesifik yang menentukan 

teknik analisis statistik yang akan digunakan. Skala 
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nominal digunakan untuk memberi label pada 

serangkaian nilai; skala ordinal memberikan urutan 

nilai; skala interval mengukur perbedaan antara setiap 

nilai, dan skala rasio menjelaskan identitas, besaran, 

nilai interval, dan jarak absolut antara dua titik pada 

skala karena 'nol sebenarnya' dapat didefinisikan 

(Anjana BS, 2021). 

 

B. Input Data 

Input data menggunakan instrumen seperti 

kuesioner atau lembar observasi yang menghasilkan 

skoring atau koding dari data yang dikumpulkan di 

lapangan. Anda dapat menginput data dengan mengklik 

tombol Data View, yang akan terlihat seperti gambar di 

bawah ini: 

 
 



12  



13  

BAB IV 

TRANSFORMASI DATA 

 

Sebelum melakukan analisis data, transformasi data 

adalah perubahan dari jenis data yang memiliki skala 

interval ke skala ordinal. Ini dilakukan melalui kategorisasi 

atau transformasi, yang digunakan untuk mengubah nilai-

nilai yang sudah ada menjadi nilai baru dalam variabel yang 

baru juga (Kim, 2013). Jika salah satu syarat uji statistik 

adalah data harus kategorisasi, transformasi data adalah 

langkah penting untuk dilakukan. Beberapa asumsi seperti 

normalitas, hubungan linier, dan homoskedastisitas sering 

kali diperlukan dalam metode analisis statistik parametrik. 

Data yang dikumpulkan dari situasi klinis atau eksperimen 

sering kali melanggar asumsi-asumsi ini. Transformasi 

variabel memberikan kesempatan untuk membuat data 

tersedia untuk analisis statistik parametrik tanpa kesalahan 

statistik. Tujuan transformasi variabel untuk memungkinkan 

analisis statistik parametrik dan tujuan akhirnya adalah 

interpretasi yang sempurna dari hasil dengan variabel yang 

ditransformasi (Feng et al., 2013). Transformasi variabel 

biasanya mengubah karakteristik dan sifat asli dari unit-unit 

variabel. Transformasi balik sangat penting untuk 

interpretasi hasil estimasi. Artikel ini memperkenalkan 

konsep umum tentang transformasi variabel, terutama 
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difokuskan pada transformasi logaritmik. Transformasi balik 

dan pertimbangan penting lainnya juga dijelaskan di sini 

(Lee, 2020). 

Khususnya untuk tipe data numerik, transformasi 

komputasi digunakan untuk membuat variabel baru atau 

mengubah nilai-nilai variabel untuk setiap kasus. Dengan 

data contoh berikut dari Kasus data : 

Item Pertanyaan 

No. 1 2 3 4 5 N 

1 4 4 4 4 3 19 

2 4 4 4 4 4 20 

3 4 4 4 5 5 22 

4 5 4 4 5 5 23 

5 4 4 5 5 5 23 

6 3 3 4 5 5 20 

7 4 4 4 3 4 19 

8 4 4 4 4 4 20 

9 5 5 5 4 4 23 

10 3 3 3 5 4 18 

 
 

Berdasarkan contoh data diketahui bahwa ada 10 

data hasil dari pengisian kuesioner dengan 5 total item 

pertanyaan yang selanjutnya dimasukkan ke dalam 

aplikasi SPSS, variabel view dengan Langkah Langkah 

sebagai berikut:  
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1. Buka program aplikasi computer SPSS, selanjutnya pada 

jendela variabel view, masukkan item kuesioner yang 

diawali pada kotak name, dan selanjutnya pada type, with, 

decimal, label, values, missing, align, measure dan role. 

 

2. Masukkan keseluruhan variable, dengan memperhatikan 

pengisian kotak values sesuai dengan kategori yang 

diiginkan 

3. Kotak type diisi dengan numeric karena data berupa angka 

4. Kotak  width tetap dengan 8 

5. Kotak decimal diganti dengan 0 karena tidak ada angka 
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dibelakang koma (1,2,3,4,5) 

6. Kotak measure dengan pilihan ordinal  

7. Selanjutnya pada data view masukkan seluruh data hasil 

penelitian  

 

8. Selanjutnya untuk mencari nilai total (N) kita gunakan menu 

transform lalu pilih compute  varibale 

 

9. Selanjutnya pada kolom taget tuliskan xt (total), dan masukkan 

keseluruhan item pertanyaan dengan memberikan tanda plus 

(+) diantara variabel tersebut lalu klik ok 
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10. Hasil yang didapatkan adalah adanya varibel baru yaitu xt 

untuk mengetahui total dari jawaban  kuesioner tersebut. 

 

 

 

11. Selanjutnya jika kita menginginkan membuat data dikotomi 

dari hasil xt maka kita dapat menggunakan menu tranform 

kembali, tranfrom> record into difference variable. 
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Catatan dalam membuat dikotomi perhatikan item koding yang 

diinginkan Ex: pada data xt jika memang tidak ada standart baku 

yang digunakan maka bisa digunakan berdasarkan dengan 

distribusi data apakah data normal adat tidak normal. 

(normal=mean; tidak normal median). 

Langkah langkah untuk mengetahui data distribusi normal atau 

tidak normal adalah sebagai berikut: 
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1. Analyze> descriptive statistics explore 

 

 

2. Masukkan total pada dependen list kalu klik plot 
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3. Setelah muncul jendela explore plot pilih normality plots with 

test, lalu continue 

 

 

 

4. Selanjutnya pada output perhatikan pada label  
 

Tests of Normality 

 

Kolmogorov-Smirnova Shapiro-Wilk 

Statisti

c df Sig. 

Statisti

c df Sig. 

Total .245 10 .092 .871 10 .102 

Lilliefors Significance Correction 
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Syarat data dikatakan normalitas, jika nilai p value >0.05, 

perlu menjadi perhatian jika jumlah sampel < 50 maka nilai yang 

digunakan berasal dari table Shapiro-wilk sedangkan untuk 

sampel yang lebih dari 50 maka melihat table Kolmogorov 

smirnov (Ghasemi & Zahediasl, 2012)  (Mishra et al., 2019). Setelah 

diketahui data berdistribusi normal atau tidak maka ketentuan 

dikotomi menggunakan data mean atau median. Berdasarkan 

hasil uji normalitas di atas dengan nilai sig. 0.102 maka hasil 

penelitian berdistribusi normal dengan demikian menggunakan 

mean sebagai acuan dalam penentuan dikotomi.  

Uji normalitas formal seperti uji Shapiro-Wilk atau uji 

Kolmogorov-Smirnov telah dikenal luas. Uji tersebut menilai 

hipotesis nol bahwa distribusi data adalah normal. Uji Shapiro-

Wilk telah dilaporkan lebih kuat daripada uji Kolmogorov-Smirnov 

dalam menguji normalitas Ketentuan distribusi data normal juga 

dapat dilihat dengan melihat nilai Skewness dan kurtosis (Kim, 

2013). Berdasarkan hasil analisis data diketahui bahwa nilai 

skewness <1.96 maka data tersebut berdistribusi normal.  

Kemudian di mulai Langkah 5 sebagai berikut: 

5. Membuat dikotomi data, dengan menggunakan 
tranform>recorde into different variable 
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6. Setelah muncul jendela recode into different variables 

masukkan xt dalam jendela numeric variable  

 
 
 
7. Output variable di isi pada bagian  name diisi sesuai dengan 

nama variabel dan tambahkan  label. 
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8. Setelah itu klik change dan old and new values. Pada range 

LOWEST through value, diisi dengan nilai mean – 0.1 = 20 – 
0.1 = 19.99 
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9. Setelah itu pada kolom value isi dengan skor 1> add 

 
 

10. Kemudian lanjutkan dengan value ya ke-2, continue> oke 
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11. Variabel tangible akan muncul pada variable vie yang sudah 
menjadi dikotomi, segera ganti decimal menjadi angka nol  
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BAB V 

UJI VALIDITAS DAN RELIABILITAS 

 

A. Uji Validitas 

Validitas adalah sejauh mana skor dari suatu pengukuran 

mewakili variabel yang dimaksudkan. Namun, bagaimana para 

peneliti membuat penilaian ini . Ketika sebuah pengukuran 

memiliki reliabilitas tes-retes dan konsistensi internal yang baik, 

para peneliti harus lebih yakin bahwa skor tersebut mewakili apa 

yang seharusnya. Namun, harus ada lebih dari itu, karena 

sebuah pengukuran bisa sangat andal tetapi tidak memiliki 

validitas sama sekali. Sebagai contoh yang tidak masuk akal, 

bayangkan seseorang yang percaya bahwa panjang jari telunjuk 

seseorang mencerminkan harga diri mereka dan karena itu 

mencoba mengukur harga diri dengan memegang penggaris ke 

jari telunjuk orang tersebut. Meskipun pengukuran ini akan 

memiliki reliabilitas tes-retes yang sangat baik, namun sama 

sekali tidak memiliki validitas (Peeters & Martin, 2017). Fakta 

bahwa jari telunjuk seseorang lebih panjang satu sentimeter dari 

jari telunjuk orang lain tidak akan menunjukkan apa-apa tentang 

siapa yang memiliki harga diri yang lebih tinggi. Diskusi tentang 

validitas biasanya membaginya menjadi beberapa "jenis" yang 

berbeda. Namun, cara yang baik untuk menginterpretasikan tipe-

tipe ini adalah bahwa jenis-jenis bukti lain-selain reliabilitas-yang 

harus dipertimbangkan ketika menilai validitas suatu ukuran. 
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Jenis jenis validitas adalah validitas muka, validitas isi, dan 

validitas kriteria. 

1. Validitas Muka 

Validitas muka adalah sejauh mana metode pengukuran 

tampak "pada wajahnya" untuk mengukur konstruk yang 

diminati. Kebanyakan orang akan mengharapkan kuesioner 

harga diri untuk menyertakan pertanyaan mengenai apakah 

mereka melihat diri mereka sebagai orang yang berharga dan 

apakah mereka merasa memiliki kualitas yang baik. Jadi, 

kuesioner yang menyertakan pertanyaan-pertanyaan 

semacam ini akan memiliki validitas wajah yang baik (Thomas 

& Harrison, 2020). Di sisi lain, metode pengukuran harga diri 

dengan menggunakan jari, tampaknya tidak ada hubungannya 

dengan harga diri dan oleh karena itu memiliki validitas muka 

yang buruk. Meskipun validitas wajah dapat dinilai secara 

kuantitatif-misalnya, dengan meminta sampel besar orang 

untuk menilai suatu ukuran dalam hal apakah ukuran tersebut 

tampaknya mengukur apa yang dimaksudkan-validitas wajah 

biasanya dinilai secara informal (Royal, 2016).  

 

2. Validitas Isi 

Validitas isi adalah sejauh mana suatu ukuran 

"mencakup" konstruk yang diminati. Sebagai contoh, jika 

seorang peneliti secara konseptual mendefinisikan kecemasan 

ujian sebagai aktivasi sistem saraf simpatik (yang 

menyebabkan perasaan gugup) dan pikiran negatif, maka 

ukuran kecemasan ujiannya harus mencakup item-item 
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tentang perasaan gugup dan pikiran negatif. Atau 

pertimbangkan bahwa sikap biasanya didefinisikan sebagai 

melibatkan pikiran, perasaan, dan tindakan terhadap sesuatu 

(Lafave et al., 2013). Dengan definisi konseptual ini, 

seseorang memiliki sikap positif terhadap olahraga sejauh ia 

berpikir positif tentang berolahraga, merasa senang 

berolahraga, dan benar-benar berolahraga. Jadi, untuk 

memiliki validitas isi yang baik, ukuran sikap orang terhadap 

olahraga harus mencerminkan ketiga aspek ini. Seperti halnya 

validitas wajah, validitas isi biasanya tidak dinilai secara 

kuantitatif. Sebaliknya, validitas isi dinilai dengan memeriksa 

secara cermat metode pengukuran terhadap definisi 

konseptual dari konstruk (McAdams & Zeldow, 1993) 

(Almanasreh et al., 2019). 

 

3. Validitas Kriteria 

Validitas kriteria adalah sejauh mana skor orang pada 

suatu ukuran berkorelasi dengan variabel lain (dikenal sebagai 

kriteria) yang diharapkan berkorelasi. Sebagai contoh, nilai 

seseorang pada ukuran baru kecemasan tes harus berkorelasi 

negatif dengan kinerja mereka pada ujian sekolah yang 

penting (Van Iddekinge et al., 2012). Jika ditemukan bahwa 

nilai seseorang ternyata berkorelasi negatif dengan performa 

ujian mereka, maka ini akan menjadi bukti bahwa nilai tersebut 

benar-benar merepresentasikan kecemasan menghadapi 

ujian. Namun jika ditemukan bahwa orang-orang mendapatkan 

nilai yang sama baiknya dalam ujian terlepas dari nilai 
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kecemasan ujian mereka, maka hal ini akan menimbulkan 

keraguan akan validitas ukuran tersebut (Boateng et al., 

2018). 

 

B. Uji Reliabilitas 

Reliabilitas mengacu pada konsistensi dari suatu 

pengukuran. Para psikolog mempertimbangkan tiga jenis 

konsistensi: dari waktu ke waktu (reliabilitas tes-retes), antar 

item (konsistensi internal), dan antar peneliti yang berbeda 

(reliabilitas antar-penilai). Peneliti mengukur sebuah konstruk 

yang mereka asumsikan konsisten dari waktu ke waktu, maka 

skor yang mereka peroleh juga harus konsisten dari waktu ke 

waktu. Reliabilitas tes-retes adalah sejauh mana hal ini benar-

benar terjadi. Sebagai contoh, kecerdasan umumnya dianggap 

konsisten dari waktu ke waktu. Seseorang yang sangat cerdas 

hari ini akan sangat cerdas minggu depan. Ini berarti bahwa 

ukuran kecerdasan yang baik seharusnya menghasilkan nilai 

yang kurang lebih sama untuk orang tersebut minggu depan 

seperti halnya hari ini. Jelas, ukuran yang menghasilkan nilai 

yang sangat tidak konsisten dari waktu ke waktu tidak dapat 

menjadi ukuran yang baik untuk konstruk yang seharusnya 

konsisten. Hasil uji reliabilitas dikatakan reliabel jika nilai nilai 

alpha cronbach >0,75 atau >0.60 (Zakariya, 2022) (McNeish, 

2018).  
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C. Langkah – Langkah Uji validitas dan Reliabilitas 

1. Uji Validitas 

Contoh data untuk uji validitas dan reliabilitas berdasarkan 

hasil penelitian dengan menggunakan kuesioner untuk 

mengukur Indeks Kepuasan Masyarakat terhadap 

pelayanan  (PermenPan RB, 2017), adalah sebagai 

berikut: 

Pertanyaan 

No U1 U2 U3 U4 U5 U6 U7 U8 U9 

1 4 3 4 3 4 4 3 4 4 

2 3 4 4 4 4 4 4 4 3 

3 3 3 3 4 4 4 4 4 4 

4 3 4 4 4 4 4 4 4 4 

5 3 4 4 3 3 4 4 4 3 

6 3 3 4 4 4 4 4 3 4 

7 4 4 2 3 4 4 3 4 3 

8 3 3 3 3 4 4 4 4 3 

9 4 4 4 4 4 4 4 4 3 

10 3 3 4 3 4 4 3 3 3 

11 4 3 4 4 3 4 4 4 4 

12 4 3 4 3 4 4 4 4 4 

13 4 3 4 4 4 4 4 4 3 

14 3 4 2 3 3 4 3 4 3 

15 3 4 3 4 4 4 4 3 3 

16 4 4 4 3 4 4 4 4 3 

17 4 3 4 3 4 4 4 4 3 



31  

18 3 4 3 3 4 4 4 2 4 

19 4 3 3 3 3 4 4 3 3 

20 3 4 3 4 4 4 4 3 3 

21 4 3 4 3 4 4 4 4 4 

22 3 4 4 3 4 3 3 4 3 

23 3 3 4 3 4 3 3 4 3 

24 3 4 3 4 4 4 3 4 4 

25 3 3 3 4 4 4 3 4 3 

26 3 3 3 4 4 4 3 2 3 

27 4 4 3 4 4 4 4 4 3 

28 4 3 3 4 4 4 4 4 4 

29 4 4 3 4 4 4 4 3 4 

30 4 4 3 3 4 4 4 3 4 

 

1) Open SPSS, sampai muncul jendela SPSS data view dan 

variabel view 
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2) Masukkan hasil kuesioner pada variabel view sesuai 

dengan hasil kuesioner dari U1 – U9 
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3) Setelah variable view diisi lalu data dimasukkan ke dalam 

data view 

 

4) Pastikan seluruh data masuk tanpa ada data yang 

terlewati, jika ada data yang belum masuk akan berdapak 

pada hasil data dengan contoh sebagai berikut 

 



34  

 

5) Hitunglah jumlah skor dari seluruh item pertanyaan dengan 

menggunakan menu transform 
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6) Setelah jendela transform muncul isikan kata total dalam 

target variabel dengan tujuan untuk membuat variabel baru 

yaitu total (jumlah U1 – U9) 

 

7) Masukkan satu persatu dari mulai U1 sampai dengan 

dengan U9 dengan menambahkan (+) lalu ok 
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8) Variabel total akan muncul pada point variabel view, 

dengan catatan peneliti harus menyesuaikan kolom 

decimal, dan label sesuai dengan kebutuhan 

 

 

9) Uji validitas dilakukan dengan memilih 

analyze>correlate>bivariate 

 

 

 



37  

10) Jendela bivariate correlation akan muncul, dan dilanjutkan 

dengan memasukkan seluruh unsur, memasukkan data 

dapat dilakukan satu persatu atau dengan ctrl + A, lalu 

dimasukkan ke variabel, dan ok 

 

 

 

 

 

 



38  

Hasil dapat dilihat dalam jendela output 

 

 

Berdasarkan hasil uji validitas tersebut dapat diketahui 

bahwa ada beberapa jawaban unsur tidak valid misalkan 

pada item nomor 2 karena nilai sig. ≥ 0.05 dan atau  nilai 

table kurang dari 0.306 (dilihat dari r table dengan rumus, 

df – 2 = 28). 
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2. Uji Reliabilitas 

Langkah Langkah uji reliabilitas adalah sebagai berikut: 

1) Analyze> scale> reliability analysis 

 

2) Setelah muncul jendela reliability analysis masukkan 

seluruh data ke items 
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3) Setelah masuk ke items, pilih statistic 

 

4) Setelah muncul jendela reliability analysis statistic, pilih 

item>scale if item lalu continue 
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5) Lihat hasil pada output SPSS, diketahui bahwa nilai 

nilai Cronbach's Alpha untuk untuk ke tujuh item soal 

adalah > 0,60 maka dikatakan reliabel. 
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